Contents

Copyrights ................................................................................. 5

1. Introduction ........................................................................ 7
   1.1. This manual .................................................................. 7
   1.2. Use of symbols .............................................................. 7
   1.3. Intended audience ......................................................... 7
   1.4. Product documentation ............................................... 8
   1.5. Document conventions ............................................... 8
   1.6. Revision history .......................................................... 9

2. Safety information .................................................................. 11

3. Product overview ..................................................................... 13
   3.1. SPA-ZC 400 and optional LON/SPA interface ............... 14
   3.2. Features ......................................................................... 14
   3.3. Transmission Control Protocol (TCP) ............................ 15

4. Installation ................................................................................ 17
   4.1. Mechanical installation ................................................... 17
   4.2. Communication Engineering Tool for SPA-ZC 40x ........... 17
      4.2.1. System requirements ........................................... 17
      4.2.2. Installing Communication Engineering Tool for
              SPA-ZC 40x..................................................... 17
      4.2.3. Uninstalling Communication Engineering Tool
              for SPA-ZC 40x............................................. 18
   4.3. Connecting to SPA-ZC 400 ............................................. 18
      4.3.1. Changing computer's IP address .............................. 19
      4.3.2. Checking connection to SPA-ZC 400 ....................... 19

5. Engineering .............................................................................. 21
   5.1. Overview of engineering .............................................. 21
   5.2. Creating project ............................................................ 21
   5.3. Restarting ....................................................................... 22
   5.4. Building object tree ...................................................... 23
      5.4.1. Adding Device object........................................... 25
      5.4.2. Adding Logical Device objects ............................... 25
   5.5. Configuring by using imported CID file ........................... 25
   5.6. Configuring communication parameters ......................... 26
      5.6.1. Uplink network settings ....................................... 26
      5.6.2. Communication parameters for Modbus ................... 28
   5.7. Downloading configuration .......................................... 29

6. Commissioning ......................................................................... 31
   6.1. Checking Modbus TCP communication ........................... 31

7. Technical data ............................................................................ 33
7.1. Interfaces ............................................................... 33
7.2. Test and conditions .................................................. 35

8. Maintenance and service ..............................................37
  8.1. LED indicators ....................................................... 37
  8.2. Communication settings ........................................... 37
  8.3. IP Query ................................................................. 38
  8.4. Identification .......................................................... 40
  8.5. Obtaining error logs ............................................... 41

9. Ordering information ..................................................43
10. Terminology ...............................................................45
11. Abbreviations .............................................................47
Copyrights

The information in this document is subject to change without notice and should not be construed as a commitment by ABB Oy. ABB Oy assumes no responsibility for any errors that may appear in this document.

In no event shall ABB Oy be liable for direct, indirect, special, incidental or consequential damages of any nature or kind arising from the use of this document, nor shall ABB Oy be liable for incidental or consequential damages arising from use of any software or hardware described in this document.

This document and parts thereof must not be reproduced or copied without written permission from ABB Oy, and the contents thereof must not be imparted to a third party nor used for any unauthorized purpose.

The software or hardware described in this document is furnished under a license and may be used, copied, or disclosed only in accordance with the terms of such license.

© Copyright 2009 ABB Oy

All rights reserved.

Trademarks

ABB is a registered trademark of ABB Group. All other brand or product names mentioned in this document may be trademarks or registered trademarks of their respective holders.

Guarantee

Please inquire about the terms of guarantee from your nearest ABB representative.
1. Introduction

1.1. This manual

This manual provides thorough information on the SPA-ZC 400 Ethernet Adapter and the central concepts related to it. SPA-ZC 400 Ethernet Adapter is used for connecting REF 541/3/5, REM 543/5 and RET 541/3/5 Intelligent Electronic Devices (IED) to the Modbus/TCP Bridge. In the manual you find information on SPA-ZC 400 and its components, an introduction to engineering tasks and a description of the basic operations.

The information in this manual is intended for application engineers, who install and configure SPA-ZC 400.

1.2. Use of symbols

This publication includes the following icons that point out safety-related conditions or other important information:

- The electrical warning icon indicates the presence of a hazard which could result in electrical shock.

  ![Electrical Warning]

  The electrical warning icon indicates the presence of a hazard which could result in electrical shock.

- The caution icon indicates important information or warning related to the concept discussed in the text. It might indicate the presence of a hazard which could result in corruption of software or damage to equipment or property.

  ![Caution]

  The caution icon indicates important information or warning related to the concept discussed in the text. It might indicate the presence of a hazard which could result in corruption of software or damage to equipment or property.

- The information icon alerts the reader to relevant facts and conditions.

  ![Information]

  The information icon alerts the reader to relevant facts and conditions.

It should be understood that operation of damaged equipment could, under certain operational conditions, result in degraded process performance leading to information or property loss. Therefore, comply fully with all notices.

1.3. Intended audience

This manual is intended for installation personnel, administrators and skilled operators to support installation of the software.
1.4. **Product documentation**

<table>
<thead>
<tr>
<th>Name of the manual</th>
<th>Document ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>SPA-ZC 400 configuration CD</td>
<td>1MRS151048</td>
</tr>
<tr>
<td>CAP 505 User's Guide</td>
<td>1MRS752292-MUM</td>
</tr>
<tr>
<td>SPA-ZF Optical glass fibres, multimode graded index type</td>
<td>1MRS755371</td>
</tr>
<tr>
<td>Plastic-core fibre-optic cables, Features and instructions for mounting</td>
<td>1MRS752089</td>
</tr>
</tbody>
</table>

1.5. **Document conventions**

The following conventions are used for the presentation of material:

- The words in names of screen elements (for example, the title in the title bar of a dialog, the label for a field of a dialog box) are initially capitalized.
- Capital letters are used for the name of a keyboard key if it is labeled on the keyboard. For example, press the CTRL key. Although the Enter and Shift keys are not labeled they are written in capital letters, e.g. press ENTER.
- Lowercase letters are used for the name of a keyboard key that is not labeled on the keyboard. For example, the space bar, comma key and so on.
- Press CTRL+C indicates that you must hold down the CTRL key while pressing the C key (to copy a selected object in this case).
- Press ALT E C indicates that you press and release each key in sequence (to copy a selected object in this case).
- The names of push and toggle buttons are boldfaced. For example, click **OK**.
- The names of menus and menu items are boldfaced. For example, the **File** menu.
- The following convention is used for menu operations: **Menu Name > Menu Item > Cascaded Menu Item**. For example: select **File > Open > New Project**.
- The **Start** menu name always refers to the **Start** menu on the Windows Task Bar.
- System prompts/messages and user responses/input are shown in the Courier font. For example, if you enter a value out of range, the following message is displayed: **Entered value is not valid**.
  
  You may be told to enter the string MIF349 in a field. The string is shown as follows in the procedure: **MIF349**
- Variables are shown using lowercase letters: **sequence name**
# Revision history

<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>History</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>30.06.2006</td>
<td>Document created</td>
</tr>
<tr>
<td>B</td>
<td>20.05.2009</td>
<td>SPA-ZC 400 2.1.2 additions</td>
</tr>
</tbody>
</table>
2. Safety information

Non-observance can result in death, personal injury or substantial property damage.

Only a competent electrician is allowed to carry out the electrical installation.

National and local electrical safety regulations must always be followed.

The device contains components which are sensitive to electrostatic discharge. Unnecessary touching of electronic components must therefore be avoided.
3. **Product overview**

SPA-ZC 400 is used to connect one REF 541/3/5, REM 543/5 or RET 541/3/5 device with the Modbus protocol over the TCP/IP network using the same Ethernet link. SPA-ZC 400 converts Modbus RTU messages to Modbus TCP. The IED is configured like Modbus RTU device. SPA-ZC400 provides simultaneous dual port communication for fibre-optic SPA and LON.

![Conceptual picture of a typical system setup](image)

*Fig. 3.-1 Conceptual picture of a typical system setup*

The mechanical and electrical connection of the Ethernet adapter to a REF 541/3/5, REM 543/5 or RET 541/3/5 interface is described in Section 4. Installation. The Ethernet adapter programming is described in Section 5. Engineering.

It is a prerequisite to understand the communication properties of Intelligent Electronic Devices (IED) before connecting to the Ethernet adapter. This information is available in the manual for the protection relay in question. It is also necessary to have basic understanding of the Modbus/TCP Bridge to which the IEDs will be connected.

ABB has tested the following third-party devices, which are recommended to be used with SPA-ZC 400:

**Industrial 10/100 MBit switches:**
- RuggedCom RS800
- RuggedCom RS1600
- Westermo FST208

**Media converters:**
- RuggedCom RMC-100-MM
- IMC McBasic MM1300
- Allied Telesyn AT-MC302-20
More tested devices can be found on the ABB web site http://www.abb.com/substationautomation.

### 3.1. SPA-ZC 400 and optional LON/SPA interface

The optional interface provides a connection between the REF 541/3/5, REM 543/5 or RET 541/3/5 device and the fibre-optic SPA and LON. The bus connection module converts incoming optical signals from the SPA and LON bus to electrical RS-485 signals for the REF 541/3/5, REM 543/5 and RET 541/3/5 devices and vice versa. It contains a service pin for LON nodes.

The optional interface can be used in loop- and star-type bus topologies. It is possible to select the idle state of module line. The light can be turn on or off. The jumpers select the bus topology (loop or star) depending on whether the light is turned on or off.

In the loop topology, the interface receives the message from the fibre-optic interface and passes it both to the fibre-optic transmitter and to the RS-485 interface. In the star topology, the interface receives the message from the fibre-optic receiver and passes it only to the RS-485 interface. If the message is received from the RS-485 interface, it is passed to the fibre-optic transmitter in both bus topologies.

The SPA bus communication uses loop and light off modes, when the module jumpers are in loop- and light off- positions. The LON bus communication uses star and light off modes, when the module jumpers are in star- and light off-positions.

In the LON bus communication the optional interface supports collision detection. The service pin is connected via the RS-485 interface to the device's Neuron chip, which is connected to the interface.

<table>
<thead>
<tr>
<th>Topology</th>
<th>Light on/off</th>
<th>Protocol</th>
</tr>
</thead>
<tbody>
<tr>
<td>Star</td>
<td>Light off</td>
<td>LON/SPA</td>
</tr>
<tr>
<td>Star</td>
<td>Light on</td>
<td>Not supported</td>
</tr>
<tr>
<td>Loop</td>
<td>Light off</td>
<td>LON/SPA</td>
</tr>
<tr>
<td>Loop</td>
<td>Light on</td>
<td>Not supported</td>
</tr>
</tbody>
</table>

### 3.2. Features

SPA-ZC 400 has the following features:

- Simultaneous dual port communication (plastic and fiber optic connections) for Modbus and LON/SPA
- Support of Modbus communication over TCP/IP
Fig. 3.2.-1 Parts of SPA-ZC 400

1 Ethernet connector
2 LON/ SPA bus connector (optional)
3 LON/ SPA Rx LED
4 LON service pin
5 LAN and diagnostics LEDs

3.3. Transmission Control Protocol (TCP)

The Transmission Control Protocol (TCP) is the most commonly used protocol for exchanging data between communication devices using Ethernet. Unlike UDP, the TCP protocol guarantees reliable transmission between applications. TCP also distinguishes data for multiple, concurrent applications running on the same host.

A data message sent as a TCP/IP message means that the higher layer Transmission Control Protocol assembles the message or file into smaller packets. These are then transmitted over the Internet and received by a TCP layer which reassembles the packets into the original message.
4. **Installation**

This chapter describes the installation of the SPA-ZC 400 module and the Communication Engineering Tool (CET) for SPA-ZC 40x. For additional information, such as technical data, maintenance and service, refer to Section 7. Technical data and Section 8. Maintenance and service.

4.1. **Mechanical installation**

Connect the SPA-ZC 400 module to REF 541/3/5, REM 543/5 or RET 541/3/5 and screw SPA-ZC 400 to the 9-pin type D-connectors. Connect the LAN cable to the LAN connector of SPA-ZC 400. The other end of the cable is connected to the Modbus protocol over TCP/IP through the Ethernet switch.

4.2. **Communication Engineering Tool for SPA-ZC 40x**

4.2.1. **System requirements**

Communication Engineering Tool (CET) for SPA-ZC 40x runs on Windows 2000, Windows XP and Windows Server 2003 operating systems. A PC capable of running one of these operating systems is sufficient also for CET for SPA-ZC 40x. For more information, refer to Section 1.4. Product documentation. The detailed system requirements can be seen below.

- 20 MB free hard disk space if Microsoft .NET Framework 1.1, which is required for running CET for SPA-ZC 40x, has already been installed.
- 100 MB free hard disk space, if the Microsoft .NET Framework 1.1 is not installed. It is installed automatically if it is not found.

4.2.2. **Installing Communication Engineering Tool for SPA-ZC 40x**

1. Uninstall the previous version.
2. Close all the open programs and insert the Communication Engineering Tool (CET) for SPA-ZC 40x installation CD to the CD-ROM drive of your PC.
3. The Installation program starts automatically. If this is not the case, open the program by starting setup.exe on the CD drive.
4. The installation wizard extracts the installation files to your local computer.
5. The CET for SPA-ZC 40x Installation program starts. In this dialog, click Next.
   - With the Back button you can return to the previous dialog, and with the Cancel button, exit the installation wizard. This applies to all the dialogs in the installation wizard.
6. Read the License Agreement, select the option I accept the license agreement and click Next to continue the installation.
   - If the option I do not accept the license agreement is selected, the Next button is not available and you cannot continue the installation.
7. Select the folder in which the application is to be installed.
To select the default folder shown at the bottom of the dialog, click Next.
To select another folder, click Browse, choose the folder you want and click Next.

8. Both manuals are installed by default on your local hard drive. Click Next to continue the installation.
   - To install a manual, click the respective manual and select Will be installed on local hard drive.
   - To install the documentation feature, click the respective manual and select Entire feature will be installed on local hard drive.
   - To install the manual when required, click the respective manual and select Feature will be installed when required.
   - Not to install the manual, click the respective manual and select Entire feature will be unavailable.

9. Click Next to begin the installation.

10. Follow the progress of the installation in a dialog that also shows the directory path where the files are copied. At this point, you can still cancel the installation by clicking Cancel.

11. A dialog opens to show that the tool has been successfully installed. Close the dialog and finish the installation by clicking Finish.

12. When clicking Finish, the wizard also installs the Microsoft SQL Server automatically, if it is not installed already.

13. Start CET for SPA-ZC 40x by selecting Start > Programs > Communication Engineering Tool for SPA-ZC 40x > Communication Engineering Tool.

### 4.2.3. Uninstalling Communication Engineering Tool for SPA-ZC 40x

1. Open the Add or Remove Programs dialog by selecting Start > Settings > Control Panel > Add or Remove Programs.
2. Select Communication Engineering Tool (CET) for SPA-ZC 40x and click Remove.

   Uninstall CET for SPA-ZC 40x in order to install a new version and to update the software. Uninstallation does not remove the Microsoft SQL Server and .NET Framework. Removing these programs can affect the functionality of the other ABB applications.

   Detailed instructions for upgrading the software are provided when the upgrade is available.

### 4.3. Connecting to SPA-ZC 400

The Sections 4.3.1. and 4.3.2. describe how to connect to SPA-ZC 400 from the Communication Engineering Tool (CET) for SPA-ZC 40x.
### 4.3.1. Changing computer's IP address

To connect SPA-ZC 400, the used computer and SPA-ZC 400 must use the same address space.

To change the computer's IP address space to be the same as in SPA-ZC 400:
1. Open the Network Connections in Control Panel.
2. Type, for example, the following IP address to the IP address box: 192.168.2.1. See Fig. 4.3.1.-1.

You must have system administration rights to perform the task.

![Changing IP address](image)

**Fig. 4.3.1.-1** Changing IP address

### 4.3.2. Checking connection to SPA-ZC 400

Check the connection to SPA-ZC 400 by using the ping command:
1. Open the Run dialog.
2. Type `cmd` to the Open box, see Fig. 4.3.2.-1.
Fig. 4.3.2.-1 Starting command prompt

3. Click OK to run the command prompt.
4. Type `ping 192.168.2.10`, see Fig. 4.3.2.-2.

Fig. 4.3.2.-2 Pinging SPA-ZC 400

SPA-ZC 400 responds to the ping command if the computer and SPA-ZC 400 are on the same network.

5. If SPA-ZC 400 responds with the IP address, the connection is established between the computer and SPA-ZC 400.
5. Engineering

This section guides when performing the engineering tasks required before using SPA-ZC 400.

Note that all the possible engineering scenarios are not included in this manual. You must have engineering rights to be able to perform the tasks described in this section.

5.1. Overview of engineering

The engineering and maintenance of SPA-ZC 400 is done by using CET for SPA-ZC 40x functions. The device's communication structure is described in the Project Explorer dialog. The structure is built by using device objects. These objects have communication properties that can be accessed through the Object Properties dialog. These properties define for example the IP addresses, unit addresses, and descriptions.

The communication structure consists of Modbus devices.

When the structure is complete and all the objects have been set up properly, the configuration is downloaded through FTP to SPA-ZC 400 by using the CID (Configured IED Description) Export function.

The engineering tasks are the following:
1. Building an object tree by adding a device to the configuration
2. Configuring object properties, for example modifying TCP/IP address
3. Configuring Modbus communication parameters
4. Exporting configuration data to SPA-ZC 400

5.2. Creating project

You need to start the Communication Engineering Tool (CET) for SPA-ZC 40x to open and name a project, see Fig. 5.2.-1 and Fig. 5.2.-2.
5.3. Restarting

Use this function to restart the SPA-ZC 400 at runtime.

1. Select IED and **Tools > Reset Tool** to open the restart panel, see Fig. 5.3.-1
2. Click **Reset**.

The results are reported to the UI text box.

Do not use the restart function while downloading configuration to SPA-ZC 400. When download is finished, SPA-ZC 400 is restarted automatically.
5.4. Building object tree

After creating the project you need to build and configure an object tree in the Communication Engineering Tool (CET) for SPA-ZC 40x to define the communication structure.

Fig. 5.4.-1 shows an example of the object tree when it has been built. In the example tree you can see the SPA-ZC 400 object and its child objects as devices and data objects. Indentation is used to indicate the parent-child relationship between the objects.
You have several possible ways to add objects to the object tree in the communication structure:

- You can use the right mouse button (right-click) to select the object to which you want to add a child object.
- You can copy the object.
- You can select the object using a drag-and-drop operation

Add the objects in the following order:

1. SPAZC40x_MODBUS Device object (SPA-ZC 40x)
2. Logical Device objects
3. Logical Node objects
4. Data objects
5.4.1. Adding Device object

To build the object tree:

1. Add a SPAZC40x_MODBUS Device object in the communication structure by selecting the project name.
   
   In the example, the project Protocol Test is selected.

2. Right-click Protocol Test
3. Select New > Tunneling > SPAZC40x_MODBUS, see Fig. 5.4.1.-1.

A project can contain several tunneling device objects, for example all substation feeders.

Ensure that the new IED name is unique within the planned network by renaming the IED, for example REF545_F1.

A Tunneling Device object cannot be configured for an IEC 61850 gateway.

5.4.2. Adding Logical Device objects

For tunneling devices, there is no need to add logical devices inside the parent object. Logical devices LD0 and LD1 are already included to maintain the SCL compatibility.

5.5. Configuring by using imported CID file

If you have to configure several SPA-ZC 400 with the similar settings, it is possible to import a previously generated CID file and change the communication addresses, typically by changing the IP address.
Create a new project and add a SPAZC40x_MODBUS Device. Select the CID import function by right-clicking the LD1 logical device. In the CID import dialog you can select the right CID file from the workstation directory and import it to a previously created logical device.

5.6. Configuring communication parameters

SPA-ZC 400 communication parameters are located in the device properties. SPA-ZC 400 uses static IP addresses, which have to be defined in the planned network structure.

For uplink network settings, see Sections 5.6.1. Uplink network settings and 5.6.2. Communication parameters for Modbus.

5.6.1. Uplink network settings

![Image: Uplink network settings](image-url)

**Fig. 5.6.1.-1 Uplink network settings**
• **Default Gateway**

The IP address Default Gateway defines the gateway address that forwards the IP traffic between the local subnet and the outside world. The default IP address is 192.168.2.1 and this has to be changed according to the planned network structure.

• **IP Address**

The IP address identifies SPA-ZC 400 in the local area network (LAN). All communication via SPA-ZC 400 uses this address. The default value 192.168.2.10 has to be changed to a unique address according to the planned network structure.

• **SNTP Servers**

SPA-ZC 400 uses SNTP as its own real-time clock. The time is used to synchronize an IED with Modbus. The secondary SNTP server is used if the primary SNTP server for some reason drops off the network.

• **Subnet mask**

The Subnet mask address defines which addresses have access to the default gateway.

• **TCP-Keepalive**

The status of the TCP/IP connection is monitored by transmitting keep alive-messages at configured intervals. This is done invisibly to the user. The value is in minutes and the default is 10 minutes.
5.6.2. Communication parameters for Modbus

- **Baud Rate**
  
The possible communication speed settings of the Modbus bus are:
  - 1200 bps
  - 2400 bps
  - 4800 bps
  - 9600 bps
  - 19200 bps
  - 38400 bps

- **Receive Timeout**
  
Receive Timeout defines how long SPA-ZC 400 waits for the slave’s respond before it considers the slave to be non-responding. The unit is milliseconds.

- **Retransmissions**
Retransmissions defines how many times a message is resent after connection is considered to be temporarily broken.

- **Modbus-Timesynch**
  
  If enabled, SPA-ZC 400 sends time synchronization messages to the relay. If SPA-ZC 400 is not connected to a SNTP server, time synchronization to the slave should be disabled as well.

- **Time Zone Correction**
  
  Due to the SNTP time synchronization, a time offset must be added to the Modbus time synchronization message depending on the time zone. The value is in minutes and ranges from -720 to 720. It is comparable to the Coordinated Universal Time (UTC).

- **PriorityClient1…PriorityClient4**
  
  When using multiple Modbus clients, there can be up to four so called Priority Clients. These clients are never disconnected by SPA-ZC 400. A client, who is not a Priority Client, can be disconnected to ensure a new client connection if the maximum number of connections is exceeded.

- **NormalCRCOrder**
  
  If enabled, the low–order byte of the Modbus Checksum field is appended first, followed by the high–order byte. In this case, the CRC high–order byte is the last byte to be sent in the message.

### 5.7. Downloading configuration

After you have built the object tree and done the communication configuration, you can download the configuration to SPA-ZC 400:

1. Select the SPAZC40x_MODBUS Device object and right-click to select the CID Export.

2. If you download configuration to SPA-ZC 400 the first time, change the IP address from default address (192.168.2.10) to new IP address according to the planned network structure.

When downloading the device's configuration, the device’s current IP address must be used as Target IP Address, see Fig. 5.7.-1. When using previously non-configured SPA-ZC 400, default value (192.168.2.10) should be used.

When the new configuration to SPA-ZC 400 is downloaded, Communication Engineering Tool (CET) checks if the basic IP addresses are changed. If a change is detected, CET asks whether new addresses are taken into use. If the changes are not accepted, SPA-ZC 400 uses the old IP address from the previous configuration. The IP addresses can be verified with, for example, IP Query Tool. For more information about IP Query Tool, refer to Section 8.3. IP Query.
If SPA-ZC 400 is connected to a system where the connection to it can be obtained, the Export function tries to determine the SPA-ZC 400 version and exports the export file accordingly. If the connection is disabled, prompt the correct version to be exported, see Fig. 5.7.-2.

Fig. 5.7.-1 Downloading the device's configuration

Fig. 5.7.-2 Selecting correct SPA-ZC 400 version to be exported
6. Commissioning

The downloaded Configuration file is taken into use when SPA-ZC 400 is restarted automatically.

Normally, the device is reset automatically after the configuration is downloaded with Communication Engineering Tool (CET) for SPA-ZC 40x.

After downloading the configuration you can check the basic TCP/IP functionality with the ping command in command prompt:

```
c:\>ping x.x.x.x.
```

You can see how the configuration process is progressing from the diagnostic LEDs. When the SPA-ZC 400 configuration is completed, the green LED is on.

If the configuration fails, check the error log files from the SPA-ZC 400 file system. The status and error logs are located in the /log directory. For more information about maintenance, refer to Chapter 8. Maintenance and service.

6.1. Checking Modbus TCP communication

To check the Modbus TCP communication, open the MODBUS/TCP client, for example Communication Engineering Tool (CET) for the IEC 61850 OPC Server, then send a Read Holding Registers message querying some Modbus points supported by the Modbus slave connected to the serial port of SPA-ZC 400. In the reply you receive the slave’s data for those registers.

If you have Modbus Time Synchronization enabled in the SPA-ZC 400 configuration, you see the Modbus communication indicator LEDs blinking periodically even if the MODBUS/TCP client is not connected.
7. Technical data

7.1. Interfaces

IED interface

- Fixed mechanics and fixed connectors for REF 541/3/5, REM 543/5 and RET 541/3/5 protection relays
  - D-type subminiature connector for simultaneous dual port communication (optional, see Table 3.1.).

Ethernet interface

- Multimode MT-RJ
- Multimode LC
- RJ-45 for STP CAT5e

LON/SPA interface (Optional)

- Fibre-optic connector options
  - ST multimode glass fibre transmitter/receiver pair or
  - Snap-in multimode plastic fibre transmitter/receiver pair

Optical fibres

- See fibre-optic guides:
  - SPA-ZF Optical glass fibres, multimode graded index type
  - Plastic-core fibre-optic cables, features and instructions for mounting

For more information, see Section 1.4. Product documentation.

Diagnostic LEDs

SPA-ZC 400 common diagnostic LEDs

- Power
- Diagnostic
  - Red
  - Green
  - Yellow

LAN diagnostic LEDs

- LINK
- TX
- RX
LON/SPA diagnostic LED

- RX

Dimensions and weight

![Diagonal View of SPA-ZC 400 Module](image)

**Fig. 7.1.-1**  Dimensions of the SPA-ZC 400 module

<table>
<thead>
<tr>
<th>Type</th>
<th>Dimensions [mm]</th>
<th>Weight [g]</th>
</tr>
</thead>
<tbody>
<tr>
<td>SPA-ZC 400</td>
<td>195 x 50 x 26</td>
<td>130</td>
</tr>
</tbody>
</table>
7.2. Test and conditions

Table 7.2.-1 Environmental test and conditions

<table>
<thead>
<tr>
<th>Test Type</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recommended service temperature range</td>
<td>-10...+55°C according to the IEC 60068-2-48</td>
</tr>
<tr>
<td>(continuous)</td>
<td></td>
</tr>
<tr>
<td>Transport and storage temperature range</td>
<td>-40...+85°C according to the IEC 60068-2-48</td>
</tr>
<tr>
<td>Dry heat test</td>
<td>According to the IEC 60068-2-2</td>
</tr>
<tr>
<td>Dry cold test</td>
<td>According to the IEC IEC 60068-2-1</td>
</tr>
<tr>
<td>Damp heat test, cyclic</td>
<td>According to the IEC 60068-2-30</td>
</tr>
</tbody>
</table>

Table 7.2.-2 Electromagnetic compatibility tests

<table>
<thead>
<tr>
<th>Test Type</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>EMC immunity test level</td>
<td>According to the IEC 60255-22-1</td>
</tr>
<tr>
<td>1 MHz burst disturbance test, class III</td>
<td></td>
</tr>
<tr>
<td>• Common mode</td>
<td>2.5 kV</td>
</tr>
<tr>
<td>• Differential mode</td>
<td>1.0 kV</td>
</tr>
<tr>
<td>Electrostatic discharge test, class III</td>
<td>According to the IEC 61000-4-2 and IEC 60255-22-2</td>
</tr>
<tr>
<td>• For contact discharge</td>
<td>6 kV</td>
</tr>
<tr>
<td>• For air discharge</td>
<td>8 kV</td>
</tr>
<tr>
<td>Radio frequency interference tests</td>
<td></td>
</tr>
<tr>
<td>• Conducted, common mode</td>
<td>According to the IEC 61000-4-6 and IEC 60255-22-6</td>
</tr>
<tr>
<td></td>
<td>f=150 kHz...80 MHz</td>
</tr>
<tr>
<td>• Radiated, amplitude-modulated</td>
<td>According to the IEC 61000-4-3 and IEC 60255-22-3</td>
</tr>
<tr>
<td></td>
<td>10 V/m, f=80...2700 MHz</td>
</tr>
<tr>
<td>• Radiated, pulse-modulated</td>
<td>According to the EN 50204 and IEC 60255-22-3</td>
</tr>
<tr>
<td></td>
<td>10 V/m, f=900 MHz</td>
</tr>
<tr>
<td>Fast transient disturbance tests</td>
<td></td>
</tr>
<tr>
<td>• All terminals</td>
<td>According to the IEC 60255-22-4 and IEC 61000-4-4</td>
</tr>
<tr>
<td></td>
<td>4 kV</td>
</tr>
<tr>
<td>Surge immunity test</td>
<td>According to the IEC 61000-4-5</td>
</tr>
<tr>
<td>• Power supply</td>
<td>4 kV line-to-earth, 2 kV line-to-line</td>
</tr>
<tr>
<td>Power frequency (50 Hz) magnetic field</td>
<td>300 A/m continuous</td>
</tr>
<tr>
<td>IEC 61000-4-8</td>
<td></td>
</tr>
<tr>
<td>Electromagnetic emission tests</td>
<td></td>
</tr>
<tr>
<td>• Conducted, RF-emission (Mains terminal)</td>
<td>According to the EN 55011</td>
</tr>
<tr>
<td></td>
<td>EN 55011, class A, IEC 60255-25</td>
</tr>
<tr>
<td>Radiated RF-emission</td>
<td></td>
</tr>
<tr>
<td></td>
<td>EN 55011, class A, IEC 60255-25</td>
</tr>
<tr>
<td>CE approval</td>
<td>Compiles with the EMC directive 2004/108/EC and the LV directive 2006/95/EC</td>
</tr>
</tbody>
</table>
### Table 7.2.-3  Standard tests

<table>
<thead>
<tr>
<th>Mechanical tests</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Vibration tests (sinusoidal)</td>
<td>According to the IEC 60255-21-1, class I</td>
</tr>
<tr>
<td>Shock and bump test</td>
<td>According to the IEC 60255-21-2, class I</td>
</tr>
</tbody>
</table>

### Table 7.2.-4  Standard tests

<table>
<thead>
<tr>
<th>Supply current consumption</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Running</td>
<td>340 mA</td>
</tr>
<tr>
<td>Start up</td>
<td>430 mA</td>
</tr>
</tbody>
</table>
8. Maintenance and service

If the SPA-ZC 400 module or a part of it is found to be faulty, the normal service operation is to replace the entire module.

8.1. LED indicators

Table 8.1.-1 LED indicators

<table>
<thead>
<tr>
<th>LED</th>
<th>Color</th>
<th>State</th>
<th>Sequence number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power</td>
<td>Green</td>
<td>On</td>
<td></td>
<td>Power on</td>
</tr>
<tr>
<td>Link LAN</td>
<td>Green</td>
<td>On</td>
<td></td>
<td>Indication for LAN link OK</td>
</tr>
<tr>
<td>RX LAN</td>
<td>Green</td>
<td>On</td>
<td></td>
<td>Indication for incoming LAN traffic</td>
</tr>
<tr>
<td>TX LAN</td>
<td>Green</td>
<td>On</td>
<td></td>
<td>Indication for outgoing LAN traffic</td>
</tr>
<tr>
<td>DIAG</td>
<td>Green Red</td>
<td>Off Flashing On</td>
<td>1</td>
<td>Bootloader booting</td>
</tr>
<tr>
<td></td>
<td></td>
<td>On</td>
<td>2</td>
<td>Bootloader, missing boot image</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Flashing Off</td>
<td>3</td>
<td>Starting</td>
</tr>
<tr>
<td></td>
<td></td>
<td>On</td>
<td>4</td>
<td>OK, missing configuration</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Off</td>
<td>5</td>
<td>OK, configuration in use</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Flashing</td>
<td>6</td>
<td>Configuration error</td>
</tr>
<tr>
<td>RX</td>
<td>Green</td>
<td>On</td>
<td></td>
<td>Indication for incoming LON traffic (LON and SPA)</td>
</tr>
</tbody>
</table>

Possible sequences are:

1 → 3 → 5 Normal situation
1 → 2 Missing boot image
1 → 3 → 4 Configuration file is missing
1 → 3 → 6 Configuration error

8.2. Communication settings

REF 541/3/5, REM 543/5 and RET 541/3/5 addresses or baud rates are not properly defined if:

- Diagnostic counter SPARRepIyTimo increases constantly and SPARReplyData remains 0 in the LD0.CDGIO1 logical node. These diagnostic counters are readable from the IEC 61850 client.
- Quality of the data is INVALID.

The following IED-specific settings have to be checked when setting up REF 541/3/5, REM 543/5 or RET 541/3/5:

- Protocol selection for SPA-ZC 400

Table 8.2.-1 explains the possible port configurations of REF 541/3/5, REM 543/5 or RET 541/3/5.

The protocol selection is active only after rebooting the relay. For more information, see Technical Reference Manuals of REF 541/3/5, REM 543/5 and RET 541/3/5.
Table 8.2.-1  Protocol selection for REF 541/3/5, REM 543/5 and RET 541/3/5

<table>
<thead>
<tr>
<th>Connectors/Communication parameters</th>
<th>X3.2/Protocol 2</th>
<th>X3.3/Protocol 3</th>
<th>Front connector</th>
</tr>
</thead>
<tbody>
<tr>
<td>SPA (SMS)</td>
<td>LON</td>
<td>SPA</td>
<td>SPA</td>
</tr>
<tr>
<td>SPA (SMS)</td>
<td>SPA</td>
<td>-</td>
<td>SPA</td>
</tr>
<tr>
<td>IEC 60870-5-103&lt;sup&gt;a&lt;/sup&gt;</td>
<td>LON</td>
<td>SPA</td>
<td>SPA</td>
</tr>
<tr>
<td>IEC 60870-5-103&lt;sup&gt;b&lt;/sup&gt;</td>
<td>SPA (SMS)</td>
<td>-</td>
<td>SPA</td>
</tr>
<tr>
<td>IEC 60870-5-103&lt;sup&gt;c&lt;/sup&gt;</td>
<td>-</td>
<td>SPA</td>
<td>SPA</td>
</tr>
<tr>
<td>DNP 3.0&lt;sup&gt;d&lt;/sup&gt;</td>
<td>LON</td>
<td>SPA</td>
<td>SPA</td>
</tr>
<tr>
<td>DNP 3.0&lt;sup&gt;e&lt;/sup&gt;</td>
<td>SPA (SMS)</td>
<td>-</td>
<td>SPA</td>
</tr>
<tr>
<td>DNP 3.0&lt;sup&gt;f&lt;/sup&gt;</td>
<td>-</td>
<td>SPA</td>
<td>SPA</td>
</tr>
<tr>
<td>Modbus</td>
<td>LON</td>
<td>SPA</td>
<td>SPA</td>
</tr>
<tr>
<td>Modbus</td>
<td>SPA (SMS)</td>
<td>-</td>
<td>SPA</td>
</tr>
<tr>
<td>-</td>
<td>SPA</td>
<td>SPA</td>
<td>-</td>
</tr>
<tr>
<td>IEC 61850</td>
<td>LON</td>
<td>SPA</td>
<td>SPA</td>
</tr>
<tr>
<td>IEC 61850</td>
<td>SPA</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>

<sup>a</sup> Not included in REM 543/5
<sup>b</sup> Not included in REM 543/5
<sup>c</sup> Not included in REM 543/5
<sup>d</sup> Not included in REM 543/5
<sup>e</sup> Not included in REM 543/5
<sup>f</sup> Not included in REM 543/5

Only one SPA client can be configured to poll SPA events from the device. By default SPA-ZC 400 is configured to poll SPA events. In this case, it is not allowed to poll SPA events from another SPA client.

- SPA command timeout in IED

SPA command timeout should be < 1 second when LON interlocking is not in use.

- SPA baud rate and SPA slave number in IED

Baud rate and slave number have to be according to the SPA-ZC 400 configuration in X3.2/Communication 2.

8.3. IP Query

By using the IP Query Tool in Communication Engineering Tool (CET) for SPA-ZC 40x, it is possible to see all connected SPA-ZC 40x, devices, their communication parameters and version information.

**Example:**

Sending IP query 1
RECEIVED MESSAGE FROM 10.58.125.151:
Mac Address: 00-0C-02-B0-04-89
Subnet Mask: 255.255.255.0
Default Gateway: 10.58.125.150
To use the IP Query Tool:

1. Select **Tools > IP Query Tool** to start the tool, see Fig. 8.3.-1.
   
   Query activates devices from the network until it is stopped.

![Fig. 8.3.-1 Starting the IP Query Tool](image)

2. Select the Network adapter to send a query, see Fig. 8.3.-2.
Fig. 8.3.-2 Selecting Network adapter

3. Click **Start** to start the query.
4. Click **Stop** to stop the query.

Connected devices are displayed in the Output pane, Fig. 8.3.-2.

Additional information depends on the SPA-ZC 40x version. If version 1.1.1 is used, only MAC address is displayed. If version 2.0 is used, MAC address, other address and revision information is displayed.

### 8.4. Identification

If contacting the Customer Service, it is necessary to send the following information by request:

- Version information of Communication Engineering Tool (CET) for SPA-ZC 40x
  
  Select **Help > About** to view the version information.

- SPA-ZC 400 version information
The version information can be read from the device's label. If the device is updated afterwards, use CET's IP query to get the correct version information from the device memory. For more information about IP query, refer to Section 8.3. IP Query.

8.5. Obtaining error logs

The following session transfers error.log file through ftp.

C:\>ftp x.x.x.x
User: abb
Password: abb

ftp> cd log
ftp> get error.log
ftp> quit
9. Ordering information

SPA-ZC400MMG

- Optical transmitter and receiver for SPA/LON bus
- P = plastic fibre cable
- G = glass fibre cable
- = no fibre option

- Ethernet connector type
  - M = MTRJ
  - L = LC
  - R = RJ-45

- Protocol type
  - M = Modbus/TCP
  - E = IEC 61850
  - S = SPA/TCP

- Device type

Fig. 9.-1 Ordering information for SPA-ZC 400

SPA-ZC400CD

- SPA-ZC 400 configuration CD
  - Engineering tool, Communication Engineering Tool (CET) for SPA-ZC 40x

Order at least one SPA-ZC 400 configuration CD with your delivery to get the Communication Engineering Tool. The SPA-ZC 400 package does not include the configuration CD by default.
## 10. Terminology

<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication Engineering Tool</td>
<td>Also known as CET. Software for configuring and monitoring communication gateways or communication front ends.</td>
</tr>
<tr>
<td>Intelligent Electronic Device</td>
<td>Also known as IED. Devices containing advanced logics such as meters, protection and control relays and trip units.</td>
</tr>
<tr>
<td>Modbus</td>
<td>By extension, communication board implementing the Modbus protocol for REF 542plus.</td>
</tr>
<tr>
<td>Snap-in</td>
<td>Connector type for plastic fibre cable</td>
</tr>
<tr>
<td>SPA</td>
<td>Data communication protocol developed by ABB</td>
</tr>
<tr>
<td>ST</td>
<td>Connector type for glass fibre cable</td>
</tr>
</tbody>
</table>
### Abbreviations

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CD</td>
<td>Change detect; compact disk</td>
</tr>
<tr>
<td>CET</td>
<td>Communication Engineering Tool</td>
</tr>
<tr>
<td>CID</td>
<td>Configured IED description</td>
</tr>
<tr>
<td>CRC</td>
<td>Cyclical redundancy check</td>
</tr>
<tr>
<td>EMC</td>
<td>Electromagnetic compatibility</td>
</tr>
<tr>
<td>FTP</td>
<td>File transfer protocol</td>
</tr>
<tr>
<td>IED</td>
<td>Intelligent electronic device</td>
</tr>
<tr>
<td>IP</td>
<td>Internet protocol</td>
</tr>
<tr>
<td>LAN</td>
<td>Local area network</td>
</tr>
<tr>
<td>LED</td>
<td>Light-emitting diode</td>
</tr>
<tr>
<td>LON</td>
<td>Local operating network</td>
</tr>
<tr>
<td>PC</td>
<td>Personal computer</td>
</tr>
<tr>
<td>SNTP</td>
<td>Simple Network Time Protocol</td>
</tr>
<tr>
<td>SPA</td>
<td>Data communication protocol developed by ABB</td>
</tr>
<tr>
<td>SQL</td>
<td>Structured query language</td>
</tr>
<tr>
<td>STP</td>
<td>Shielded twisted pair</td>
</tr>
<tr>
<td>TCP</td>
<td>Transmission Control Protocol</td>
</tr>
<tr>
<td>UTC</td>
<td>Universal time clock</td>
</tr>
</tbody>
</table>